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K2’s Accessing And Cleaning 
Your Company’s Data With 
Power Query And Power BI
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Discussion & Learning Objectives

• Outline Power Query's noteworthy features and 
functions and how you can use them for 
reporting projects

• Demonstrate how to connect Power Query to 
web resources, spreadsheets, and databases to 
extract, transform, and load data into your 
reports

• List the various methods to transform your data 
using Power Query before importing it into a 
report

• Demonstrate connecting Power Query and 
Power BI to a sample data server
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Today’s Major Topics
• Comprehensive grasp of Excel's Tables and Data 

Modeling

• Introduction and exploration of Excel Power Query

• Analysis of Power Query's tabs and user experience

• Examination of various Power Query connection 
options

• Techniques for common Power Query data 
transformations

• Guidance on connecting to Web, SQL, and ODBC data 
sources

• Brief look at Advanced Power Query topics
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Disclaimer & Liability Acknowledgment

• Copyright. All product names, logos, and brands are 
property of their respective owners. All company, 
product and service names used in this website are for 
identification purposes only. Use of these names, logos, 
and brands does not imply endorsement.

• Educational Use Only. The information presented in this 
presentation is for educational use only. The presenter 
will make specific recommendations, but the participant 
is highly recommended to do their own due diligence 
before making any investment decision. 

• Image Credits. Artwork and images courtesy of 
Flaticon.com, Unsplash.com and others.
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What Version Of Excel Are You Using?

• There are four essential things to know about 
the Excel version installed on your computer. 

• How did you acquire Microsoft Office? Did you 
outright purchase the license (perpetual), or do 
you have Microsoft/Office 365? 

• What level of Microsoft/Office 365 do you 
have? Family, small business, or enterprise

• What version are you running? Hopefully 2308+

• What update channel are you on? Insiders, 
current channel, semi-annual, etc. 
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Easily Check Your Office License

• You can check 
your Office 
license by 
looking at the 
product 
information 
screen in the 
file menu 

• Go to File →
Account in any 
Office 
application 
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Next Generation Excel Reporting
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MASTERING EXCEL’S TABLES &
DATA MODELING

Unlocking Insights with Tables and Relationships
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Excel Tables: Efficiency Unleashed
• Excel tables act as highly efficient data containers
• They enhance usability, efficiency and streamline Excel 

functionalities
• Tables serve as a foundation for additional Excel 

capabilities like Power Query
• They provide an optimized method for data 

referencing
• Excel tables seamlessly integrate with your existing 

workflows
• Majority of features explored will utilize tables for 

maximum efficiency
• Learn more at https://bit.ly/3NjswbZ
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Seven Main Features Of Data Tables

Tables make virtually every operation in Excel 
better due to the following features: 

• Quick and Easy Application of Formatting

• Automatic Resizing of Data Ranges

• Structured Reference Functions

• Easily filter and sort data

• Self-Replicating Functions

• Summary Rows

• Data Modeling 
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POWER QUERY 
Excel’s data transformation and data preparation engine.
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Excel Power Query

• Power Query enables connecting spreadsheets to 
dynamic data sources like databases or web content

• It eliminates manual data transfer by fetching data 
directly from the source

• The retrieval steps are preserved, facilitating future 
data updates

• Just a simple refresh is needed to update the 
workbook with new or altered records

• Power Query embodies the concept: write once, 
refresh repeatedly

• For more knowledge, visit: https://bit.ly/48qz5Vn 

A Better Way to Retrieve Data In Excel
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Why Use Power Query

• Power Query transforms raw data into a refined format, 
enhancing its usability for decision-making

• It enables data from multiple sources to be combined, 
creating a comprehensive data set for analysis

• Power Query allows for automation of data refresh and 
transformation tasks, saving time and ensuring data 
accuracy

• It provides an intuitive, user-friendly interface that makes 
complex data manipulations accessible to non-technical 
users

• Power Query’s robust filtering options aid in pinpointing 
specific data, streamlining the analysis process

• The tool facilitates the creation of custom functions, 
providing flexibility to meet unique business needs

The Financial Professional’s Best Friend
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What Can You Do With Power Query?

• Import data from virtually any database, spreadsheet, website, 
and more directly into Excel

• You can import in a folder spreadsheets in one operation 

• You can clean, format, and organize your data from its source 
before being imported into Excel 

• You can create new columns from your data 

• You can resort, reorder, change the type (e.g., decimal, text, etc.), 
or filter your data into any format you might need 

• You can pivot or unpivot your data. You can also group your data 
into custom orders. 

• You can split data into separate columns or combine data into a 
new column 

• There are dozens of different data transformation tools for 
virtually every need! 
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Microsoft Power BI

• Power BI is a dashboard business intelligence 
reporting tool. You can pull data from excel 
spreadsheets, cloud services, streaming data, 
and on-premise databases concurrently. 

• Instantly know when your business needs your 
attention with real-time Power BI dashboards

• Useful for individual or organizational use. Tackle 
both big and small reporting needs. 

• Learn more about how Power BI can 
turbocharge your organization at 
https://powerbi.com.  

See your company’s data in new ways
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Power BI Dashboards

• Native integrations with 
dozens of services, 
including marketing, 
sales, human resources, 
accounting, etc. 

• Easily create beautiful 
dashboards from your 
organization’s real-time 
data

• Write once. Refresh 
many. 
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Review Time!

What Is The Key Benefit Of Using 
Power Query In Excel?

It requires complex coding for data retrieval.

It only connects spreadsheets to static data 
sources.

It enables connection to dynamic data sources 
and automates data fetching.

It allows manual data transfer from databases.
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Review Time!

What Is The Key Benefit Of Using 
Power Query In Excel?

It requires complex coding for data retrieval.

It only connects spreadsheets to static data 
sources.

It enables connection to dynamic data sources 
and automates data fetching.

It allows manual data transfer from databases.
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POWER QUERY DATA SOURCES
From Files, Databases, the Web and More
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From File

• Power Query allows importing data from 
Excel files, CSV, XML, JSON, etc.

• It supports combining data from multiple 
sources like folders or SharePoint

• These stand-alone file sources are not 
dynamically driven (e.g., not a database) 

• You can get data from a PDF or an image, but 
the quality varies widely 

Data from Static Resources
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From Database

• Power Query supports integration with 
dynamic data sources like databases

• It is compatible with all standard 
databases, including SQL, MySQL, 
Access, and more

• Some databases can be integrated 
natively without requiring additional 
setup

• However, certain databases may require 
the installation of additional drivers for 
compatibility

Leveraging Dynamic Data Sources
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From Other Services

• "From Table/Range" allows data extraction from 
another table within the same document

• The "From Web" option enables data sourcing directly 
from the Internet

• "Microsoft Query" is a legacy tool for creating and 
managing database queries

• "From ODBC" feature employs Open Database 
Connectivity tools for data extraction

• "From Picture" transforms an image into a usable data 
source

• "From Exchange & Active Directory" sources data from 
user and email directories

Expanding Data Acquisition
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Combine Queries

•Power Query allows users to merge 
multiple queries into a single output
•Users can append queries, adding data 

from one query to another
•Merging queries can facilitate the 

comparison and analysis of different data 
sets
•Appending queries aids in creating more 

comprehensive data sets for analysis

Merging and Appending Queries
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From Azure, Power Platform, And 
Online Services

Online Services

Azure

Power Platform
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Power BI: Web Connections

• Power BI facilitates robust 3rd party 
web connections through Power Query

• It offers seamless integration with 
business and financial service providers 
like QBO

• Users only need to supply their 
username and password for these 
services

• The system handles authentication, 
security, and data management on 
behalf of the user

Simplifying Data Acquisition
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THE POWER QUERY INTERFACE
Navigating the Interface with Confidence
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Functional Areas Of Power Query
1. Ribbon: Enhances 

navigation through a 
cohesive interface.

2. Queries Pane: 
Showcases an 
inventory of all 
accessible queries.

3. Current View: The 
primary workspace 
providing a default 
data preview.

4. Query Settings: 
Offers insight into 
the selected query’s 
parameters.

5. Status Bar: A real-
time update bar for 
pertinent query 
details.
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Power Query: Query Settings Overview

• The "Name" field in the query settings panel 
assigns a specific name to the query

• "Applied Steps" displays all the transformations 
performed on the data

• Every transformation applied is represented as a 
separate step

• The panel allows for the reordering, editing, or 
deletion of steps

• Steps build upon each other, making the 
sequence of steps crucial in data transformation

Managing Data Transformations
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Power Query Transformations

There are dozens of options to transform and modify your data! 
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Home Ribbon
• Close and Load
• Query (Refresh, Properties, Advanced Editor, Manage)
• Manage Columns (Choose Columns, Remove 

Columns)
• Reduced Rows (Keep Rows, Remove Rows)
• Sort
• Transform (Split Column, Group By, Use Headers, 

Replace Groups)
• Combine (Manage Queries, Append Queries)
• Manage Parameters
• Data Source Settings
• New Query (New Source, Recent Source, Enter Data)
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Transform
• Table (Group By, Use First as Header, Transpose, 

Reverse Row, Count Rows)
• Any Columns (Data Types, Rename, Replace 

Values, Fill, Pivot Columns, Unpivot Columns, 
Move, Convert to List)

• Text Columns (Split Column, Format, Merge 
Column, Extract, Parse)

• Number Column (Statistics, Standard, Scientific, 
Information, etc.)

• Date and Time Column (Date, Time, Duration)
• Structured Column (Expand, Aggregate, Extract, 

Create Data Type)
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Add Columns

• General (Column From Examples, Custom 
Column, Invoke Custom Function)

• Conditional Column, Index Column, Duplicate 
Column

• From Text (Format, Merge Columns, Extract, 
Parse)

• From Number (Statistics, Standard, Scientific, 
Information, etc.)

• From Date and Time Column (Date, Time, 
Duration)
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View

• Layout (Query Settings, Formula Bar)

• Data Preview (Monospaced, Show 
Whitespace, Column Quality, Column 
Distribution, Column Profile)

• Go to Column

• Parameters

• Advanced Editor

• Query Dependencies 
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Power Query: Closing And Loading

• "Close and Load To" allows data transition 
from Power Query back to Excel

• Data can be returned in the form of an 
organized table for easy analysis

• It supports the creation of Pivot Tables or 
Pivot Charts for data visualization

• You can opt for "Connection Only" to store 
results in memory without visible output

• Alternatively, the data can be directed to a 
data model for complex analysis purposes
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TRANSFORMATION SCENARIOS 
IN POWER QUERY

Frequent Use Cases Overview



Copyright © 2022, K2 Enterprises LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLCCopyright © 2022, K2 Enterprises LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLC

Power Query Transformations

• Power Query enables efficient data cleaning by removing 
unnecessary columns, rows, or erroneous data

• It simplifies data consolidation, pulling from multiple sources 
and combining into one unified dataset

• With Power Query, you can pivot or unpivot data to better 
structure it for analysis

• It offers robust date and time transformations, allowing for 
easy manipulation and formatting of time-series data

• Power Query aids in data normalization, converting disparate 
data types into a uniform format

• It effectively handles hierarchical data by creating parent-
child relationships or flattening structured data

Popular Use Case Insights
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Filtering Capabilities In Power Query

• Power Query’s filtering capabilities help users to isolate specific 
data subsets for targeted analysis

• To filter data, use the dropdown menu in each column header 
and select your filter criteria

• The tool offers basic filters like text, number, and date, as well as 
complex ones like conditional and custom filters

• Power Query also has an advanced filtering option, allowing for 
complex query-based filtering

• Remember, all filtering actions are reversible and adjustable, 
providing flexibility in data manipulation

Effective Data Refinement
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Column And Row Removal

• Column and row removal in Power Query helps in focusing on 
relevant data by eliminating unnecessary elements

• To remove columns, right-click on the desired column header and 
select "Remove”

• Row removal can be performed by filtering data or using the 
"Remove Rows" option in the Home tab

• Power Query supports removal of duplicate rows, enhancing data 
integrity and reducing redundancy

• Users can undo column or row removal actions, ensuring data safety
• Strategic removal of columns and rows aids in data normalization and 

preparation for analysis

Streamlining Data for Analysis
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Parsing And Splitting: Simplifying Data

• Parsing involves breaking down complex data into more 
manageable and understandable components

• To parse data, identify the format or structure you want to 
extract, usually defined by a pattern or rule

• Splitting separates data into distinct sections, often using 
predefined or custom delimiters such as commas or spaces

• To split data, locate the "Split Column" option, select your 
delimiter, and choose the positions to split at

• Parsing and splitting are essential techniques for simplifying and 
structuring data for better readability and analysis
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Pivoting And Unpivoting

• Power Query’s pivot functionality allows users to summarize vast 
datasets based on specific columns for improved legibility

• To pivot data, choose a column to act as the new headers and 
another one for the corresponding values

• The unpivot feature in Power Query converts column-based data 
into row-based data, offering a detailed view for analysis

• To unpivot, select the columns to transform, right-click and 
choose "Unpivot Columns"

• Remember, pivoting and unpivoting actions are reversible in 
Power Query, providing flexibility in data manipulation

Reshaping Data for Analysis
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Combine & Merge Data Sources

• Power Query allows users to combine and merge multiple data 
sources into one for comprehensive analysis

• To merge data, go to the "Home" tab and select "Merge 
Queries", then set your desired criteria

• Combining data is achieved through the "Append Queries" 
option in the "Home" tab

• When merging, users must specify a common column between 
the data sources for correct alignment

• Append operations stack data tables vertically while merge 
operations combine them horizontally
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Folder Data Connection

• Power Query offers the ability to connect directly to a folder of 
data for efficient analysis

• To establish a connection, select "Get Data,” then "File,” and 
finally "Folder" in the Home tab

• Users must provide the path of the folder they wish to connect 
to for data extraction

• Power Query then presents a consolidated view of all files within 
the folder for selection

• This feature helps handle multiple related data files 
simultaneously, saving time and effort

Simplifying Bulk Data Analysis
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CREATING COLUMNS IN POWER QUERY
Building New Columns in Power Query
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Crafting New Columns

• Creating new columns in Power Query enhances data manipulation 
and analysis capabilities

• The "Add Column" tab in Power Query allows users to create and 
customize new columns

• Users can generate several types of columns, such as Custom, Date, 
Conditional, and Index

• Creating new columns can aid in the computation, extraction, or 
categorization of your data

• The flexibility of Power Query's column creation allows tailoring data 
to specific analysis requirements

• Once created, these columns can be formatted, moved, renamed, or 
deleted as per user needs

Amplifying Data Analysis Capabilities
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Column Addition Process

• Navigate to the "Add Column" tab in Power Query to begin the 
process

• The "Add Column" tab presents multiple options for creating 
different types of columns

• After selecting the column type, input the necessary details or 
formulas in the dialog box

• Press "OK" and Power Query will add the new column to the 
rightmost part of your table

• Users can move or rename the new column as per their 
requirements

Enhancing Data Customization
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Custom Column Types

• Custom columns in Power Query allow user-defined expressions 
or formulas

• Date columns are used for specific date-related calculations and 
analyses

• Conditional columns enable users to create new columns based 
on conditions

• Index columns are sequential numbers added to rows to aid data 
organization

• Each column type serves specific data analysis needs, increasing 
the tool’s versatility

Customizing Data for Analysis
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Custom Columns In Action

• New columns can compute sales totals or averages in business data

• Date columns can help track project timelines or analyze time-series 
data

• Conditional columns are useful for categorizing data based on certain 
criteria

• Index columns aid in the orderly organization of large datasets

• Custom columns can facilitate complex calculations tailored to 
unique user needs

• These practical applications emphasize the versatility and 
effectiveness of Power Query

Practical Uses and Benefits
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WEB DATA EXTRACTION
Simplifying Online Data Analysis
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Extracting Data From The Web

• Power Query proficiently extracts data 
from websites, APIs, and diverse web 
data formats

• The web data should ideally be 
arranged in tables, XML, JSON, or 
similar structures for best results

• Public data or data needing 
authentication are both accessible 
through Power Query

• However, working with two-factor 
authentication (TFA) could present 
challenges

Navigating Web Data Extraction
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Navigate To The Data By URL

• Users can directly input the 
URL of the desired web data 
into Power Query for 
extraction

• Through Power Query, one 
can access and manipulate 
data from the web in real 
time

• Navigate to the URL, 
https://www.x-rates.com/. 



Copyright © 2022, K2 Enterprises LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLCCopyright © 2022, K2 Enterprises LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLC

Permissions And Credentials

• Power Query allows for 
connection via diverse access 
methods

• Anonymous access is suitable 
for public data retrieval

• The Windows method involves 
using system-based credentials

• Basic access requires the input 
of a username and password

• Web API mode allows direct 
interaction with web services

• An Organizational Account 
method is ideal for enterprise-
level data access

Authentication to a Website or API
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Navigating The Data Structure

• Power Query proficiently scans 
URLs, seeking importable 
content for Excel

• It can highlight multiple data 
sources linked to a specific URL

• Power Query allows the 
selection of either a single or 
multiple data sources

• The "Load" function facilitates 
data transfer back into Excel

• "Transform Data" directs the 
data into Power Query for 
additional alterations

Power Query Examining Data
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LET’S CONNECT VIA SQL SERVER
This is the more straightforward method of connecting to data
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Try Accessing Cloud Data Beta!

• We have set up a database playground for you to learn how to use 
Cloud accounting data. You can use this service to learn how to 
use Power Query in Excel, Power BI, etc. 

• You can work with real QuickBooks Desktop and QuickBooks 
Online data examples 

• URL→ learnsql.cpetoday.com
• UN → learnsql
• PW → LearnWithUsToday! (all one-word and case-sensitive)

• This is a new service that might be upgraded from time to time 

• Depending on what skill you’re looking to learn you can connect 
either via Microsoft SQL server or via MySQL ODBC

• We’d love to know what you think! Feel free to reach out with 
questions or comments. 

Access real-world accounting databases
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How To Connect To Learn SQL

• Open up a new blank 
workbook in Excel 

• Go to the Data tab in the 
ribbon menu 

• Click the Get Data button on 
the far left 

• Select From Database 

• Select From SQL Server 
Database

Learn to work with real cloud databases
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How To Connect To Learn SQL

• The connection dialog box 
will ask you for a server 
address 

• Provide learnsql.yoss.io, 
but don’t include the 
quote marks 

• Please note that there is 
intentionally NOT a 
protocol (e.g., https) in 
the address. It isn’t 
needed and will cause an 
issue if you include it.

Provide the server address
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How To Connect To Learn SQL

• The next screen will 
prompt you to connect to 
the server 

• You’re going to want to 
choose the database 
option. The username is 
learnsql, and the 
password is 
LearnWithUsToday!. 

• Again, please don’t 
include the quote marks, 
which are case-sensitive

Provide the server credentials
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How To Connect To Learn SQL

• Excel will warn you that 
it can’t connect over an 
encrypted connection 

• This error message can 
be ignored, and it isn’t 
critical 

• Since there is only 
sample data on this 
server, there isn’t 
anything to worry about. 
Just click okay.

Provide the server credentials
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How To Connect To Learn SQL

• The next screen will show 
you all the databases in the 
system 

• There are several DBs there, 
including sample data from 
QBO and QBD 

• Once you’ve selected a DB, 
you can pick the specific 
tables you want to work with

• You can either load the data 
straight into Excel or 
transform it with Power 
Query

Provide the server credentials



Copyright © 2022, K2 Enterprises LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLCCopyright © 2022, K2 Enterprises LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLC

LET’S CONNECT VIA ODBC
This method is more realistic to how you would connect to your data. 
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Connect To Learn SQL Via ODBC

• You need to know the bit version 
of your Office installation, so you 
download the appropriate driver 

• The bit version can either be 32-
bit or 64-bit 

• In Excel, go to the File option in 
the ribbon 

• Select the Account option at the 
bottom 

• Click the About Excel button in 
the middle of the screen 

Check your Office or Power BI bit version
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Connect To Learn SQL Via ODBC

• The 32-bit version is the default 
option but limits the amount of 
memory Excel can use. You 
should use the 64-bit version of 
Office (or any other 
application) whenever possible. 

• In the dialog box, it will tell you 
about Excel, specifically if you 
have the 32-bit or 64-bit 
version installed 

Check your Office or Power BI bit version
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Connect To Learn SQL Via ODBC

• To connect to Learn SQL via ODBC, you’re 
going to need a specific driver 

• The driver allows your computer to speak the 
same language as the database server 

• There are many different types of drivers, but 
we will use the free MySQL driver provided by 
Oracle 

• Download the appropriate driver for your 
operating system and bit version (e.g., 32 or 
64-bit) 

• The bit version MUST match your version of 
Office 

• For Windows, choose the MSI installer option, 
as it will be simpler and easier to configure 

• Download the driver from 
https://bit.ly/3FYrW0H 

Download the data driver from Oracle
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Connect To Learn SQL Via ODBC

• Once the driver is downloaded, 
install the driver on your computer, 
just like any other application 

• Once the installation is completed, 
you can configure the data source 
on your computer 

• From the Windows start menu, type 
ODBC and launch either the 64-bit 
or 32-bit version of the utility 

• Again, the bit version MUST match 
your version of Office 

• If you use the 32-bit utility but the 
64-bit version of Office, you will not 
see the configured ODBC driver 

Download and install the MySQL driver
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Connect To Learn SQL Via ODBC

• In the ODBC data source 
administrator utility, click the add 
button on the User DSN tab 

• A DSN is a data source name 

• This step will configure the Learn 
SQL service as a global data source 
for any application 

• From the create new data source 
window, select MySQL ODBC 
Unicode Driver  

• Click Finish

Configure a user DSN for ODBC
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Connect To Learn SQL Via ODBC

• Data Source Name → LearnSQL 
(Keep it short, simple, and one word 
with no spaces)

• Description → Optional

• TCP/IP Server → learnsql.yoss.io 
(Please note that there is 
intentionally NOT a protocol (e.g., 
https) in the address. It isn’t needed 
and will cause an issue if you 
include it.)

• Port → 3306

• User → learnsql

• Password → LearnWithUsToday!

• You can click the test button to 
check the connection and ensure it 
works 

Provide the MySQL database credentials
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Connect To Learn SQL Via ODBC

• Open up a new blank workbook in 
Excel 

• Go to the Data tab in the ribbon 
menu 

• Click the Get Data button on the far 
left 

• Click the From Other Sources

• Click From ODBC

Access the ODBC connection in Excel 
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Connect To Learn SQL Via ODBC

• From the ODBC connection 
menu, choose your recently 
configured connection (e.g., 
LearnSQL) 

•  In the authentication screen, 
choose the Default or Custom 
option 

• You don’t need to provide any 
additional authentication 
information as you provided it 
when you configured the ODBC 
connection

• Click Connect to establish a 
connection to the database 
server  

Access the ODBC connection in Excel 
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Connect To Learn SQL Via ODBC

• The next screen will show 
you all the databases in 
the system 

• There are several DBs with 
tons of sample data

• Once you’ve selected a 
DB, you can pick the 
specific tables you would 
like to work with

• You can load the data into 
Excel or transform it with 
Power Query

Provide the server credentials



Copyright © 2022, K2 Enterprises LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLCCopyright © 2022, K2 Enterprises LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLC

CData: Bridging Data Access

• CData is instrumental when native data access is 
lacking in your application; it serves as a vital 
helper tool.

• It offers connectors to a wide array of commonly 
used business and accounting applications, 
ensuring easy data accessibility

• These connectors open gates to potentially 
inaccessible data, strengthening your data 
management

• Connectors to a wide range of accounting, ERP, 
CRM, and other applications 

• Learn more at https://www.cdata.com/ 

Connector Solutions Simplified
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QODBC: A QuickBooks Interface

• QODBC is a forward-thinking tool aiding ODBC 
connections to QuickBooks for smooth data extraction

• It serves as a link between QuickBooks and ODBC-
supporting applications, enabling data queries sans 
coding

• QODBC offers a bidirectional connection, permitting 
data pull and push to and from QuickBooks

• With its platform versatility, QODBC works efficiently 
with Excel, Access, Crystal Reports, and other ODBC-
compliant software

• It accommodates all key QuickBooks versions, such as 
Pro, Premier, Enterprise, along with global editions

Simplifying Data Access
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LET’S CONNECT VIA API
This method is often used to connect to Cloud data and applications
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What Is An API? Why Do I Need It?

• An API (Application Programming Interface) is 
a set of protocols, routines, and tools for 
building software and applications 

• It provides a way for different software 
systems to communicate with each other and 
exchange data

• APIs are often used to CRUD with the data in 
your database 

• It is the safest, fastest, and easiest way to 
work with data 
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What Is CRUD To A API/Database?

• CRUD stands for Create, Read, Update, and 
Delete. It's a set of operations performed on 
data in a database or any other storage system.
• Create. The create operation is used to insert new 

data into the database. It adds a new record to the 
table.

• Read. The read operation retrieves data from the 
database. It fetches the data from the table.

• Update. The update operation is used to modify 
existing data in the database. It changes the data in 
the table.

• Delete. The delete operation removes data from the 
database. It deletes the data from the table.
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Why Are APIs Awesome To Use

• Integrating with other systems. If you want to integrate your system with other 
systems, such as an e-commerce platform, a payment gateway, or a social media 
platform, you can use their APIs to exchange data and perform various operations.

• Automating tasks. APIs allow you to automate tasks and perform them 
programmatically, reducing the need for manual intervention.

• Enhancing user experience. By using APIs, you can enhance the user experience 
by providing a more seamless and integrated experience, for example, by 
integrating maps, weather, or other data into your application.

• Monetizing your data. If you have valuable data, you can use APIs to monetize it 
by allowing other companies or developers to access it and build new products 
and services around it.

• Building new applications and services. APIs are essential for creating new 
applications and services, allowing you to leverage existing functionality and data 
and build new products more quickly and cost-effectively.
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What Is A REST API?

• REST: A Simple and Effective Way to Share Data

• Interoperability between Computer Systems: REST makes it easy 
for two different systems to exchange data without having to 
know much about each other.

• The Internet's Lingua Franca: With REST, you can easily integrate 
with other organization applications, providing internet 
interoperability.

• Effortless Data Transfer: Support for REST means you can easily 
import and export data from your system.

Representational State Transfer – API
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Postman

• Postman is an API development and testing tool that allows 
developers to send HTTP requests and view responses easily

• It provides a user-friendly interface that simplifies the process of 
crafting and sending API requests, making it easier to test and 
debug API interactions

• Postman supports various request methods such as GET, POST, 
PUT, DELETE, and others and allows you to save and reuse 
collections of requests for later use

• It provides a range of features for working with APIs, including 
environment variables, pre-request scripts, test scripts, and more, 
making it a comprehensive tool for API development and testing

• Free for personal use and $12/user/month for team access 

• Learn more at https://www.postman.com/  

A fantastic tool to work with APIs
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Connect To An API Today! 

• Check out https://learnsql.cpetoday.com/api/ for an overview of 
the Learn SQL API and connect to sample order and product 
data 
• https://learnsql.cpetoday.com/api/Order

• https://learnsql.cpetoday.com/api/OrderItem 

• https://learnsql.cpetoday.com/api/Customer 

• https://learnsql.cpetoday.com/api/ProductCategory

• https://learnsql.cpetoday.com/api/Product 

• This is a real REST API and will give you real-world experience 
working with cloud JSON data
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ADVANCED POWER QUERY TOPICS 
Diving Deeper into Advanced Power Query Topics
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Power Query: Advanced Insights

• Understanding the role of parameters in 
Power Query

• Getting familiar with Advanced Editors and M 
Language

• Creating and using custom functions 
effectively

• Forming custom data types for better 
organization

• Integrating Power Pivot for data analysis

Moving Beyond the Basics
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Navigating Advanced Editor

• Advanced Editor in Power Query helps craft 
and refine M Language code

• M Language offers a case-sensitive, 
functional data scripting language

• Features of M Language include data 
shaping, transformation, and combination 
capabilities

• Utilizing Advanced Editor allows for creating, 
viewing, and modifying M Language scripts.

• Learn more about M at https://bit.ly/3ZyQffK 

Mastering M Language
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Navigating Advanced Editor

• The Advanced 
Editor presents 
the M code for a 
Power Query

• You can add, edit, 
or delete code to 
achieve specific 
outcomes 

• Each row within 
the Advanced 
Editor signifies a 
distinct query step
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Parameters In Power Query

• Excel Workbooks enable the creation of parameters 
passed to Power Query

• Parameters like dates, customer IDs, or GL Account 
Numbers are applicable

• Using parameters in Power Query enables specific 
record lookups

• Parameters aid in filtering records before importing 
data into Excel, limiting data scope

• The use of parameters enhances work productivity by 
enabling multi-purpose functionality

• Learn more at https://bit.ly/3PsXcub 

Amplifying Data Efficiency
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Custom Functions In Power Query

• Custom functions in Power Query facilitate 
repetitive data transformation tasks

• Use custom functions to apply complex 
transformations across multiple queries

• Debugging custom functions often involves 
isolating the function and test running it

• For efficiency, convert often-used steps into 
custom functions for easy reuse

• Keep a repository of your custom functions for 
future reference and use

• Learn more at https://bit.ly/3PQfaYZ 
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Creating Custom Data Types

• Excel‘s Power Query allows the creation of custom 
data types from any supported data source

• The process involves importing data with Power 
Query, shaping it, and loading it into a worksheet

• Custom data types can be viewed in an Excel table, 
displayed as a card, or used in formulas

• Creating a custom data type involves selecting 
relevant columns and defining the data type name 
and display column

• The newly created custom data type collapses 
initially selected columns into one for easier data 
manipulation



Copyright © 2022, K2 Enterprises LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLCCopyright © 2022, K2 Enterprises LLCCopyright 2022, K2 Enterprises, LLCCopyright 2024, K2 Enterprises, LLC

AI Insight Tools

• AI Insights in Power BI provides access to pre-trained machine 
learning models, enhancing data preparation

• Functions for Text Analytics and Vision are available from Azure 
Cognitive Services, enriching your data in Power Query

• AI Insights can be accessed directly from the Home and Add 
Column tabs in Power Query Editor

• Power BI’s AI Insights supports Sentiment Analysis, Key Phrase 
Extraction, Language Detection, and Image Tagging

• Power BI Premium is required for Text Analytics or Vision features, 
supporting extensive nodes and memory customization

• AI Insights is compatible with Excel for Microsoft 365, Excel 2019, 
Excel 2016, and Excel 2013

Machine Learning in Power Query
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Power Pivot: A Deep Dive

• Power Pivot empowers users to create data models, 
form relationships, and perform calculations

• It allows for extensive data handling, intricate 
relationships, and diverse calculations in a high-
performance Excel environment

• Capable manage large data volumes from various 
sources within a single Excel document

• Power Pivot operates directly within Excel as an in-
memory SQL Server Analysis Services engine

• It’s accessible on Excel for Microsoft 365, Excel 2019, 
Excel 2016, and Excel 2013

• For more insights, visit: https://bit.ly/3O31rMc  

Excel’s Data Modeling Tool
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Excel’s Data Modeling Magic

• Data modeling in Excel involves organizing data in a 
structured format

• It allows for the creation of relationships between 
different data sets

• Data modeling enables effective management and 
analysis of large volumes of data

• It enhances the functionality of Pivot Tables and Pivot 
Charts

• Excel’s data modeling facilitates advanced data 
analysis and forecasting

• It ultimately drives efficient decision-making by 
providing a clear view of data

Structuring for Success
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Excel Data Model

• Excel’s Data Model integrates data from various tables

• It builds a relational data source within an Excel 
workbook

• This Model underpins PivotTables and Pivot Charts

• It’s visualized as a collection of tables in a Field List

• The Data Model enables the creation of Pivot Tables 
from multiple worksheets

• It’s crucial for leveraging Power Pivot and generating 
dynamic reports

• Learn more at https://bit.ly/3OwKPxK 

A Database Right Inside Your Excel
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Data Models: Practical Applications
• Data models facilitate sales forecasting by integrating 

historical and market data
• They can help identify trends and patterns in customer 

behavior
• Data models assist in budget planning by combining 

various financial data
• They are utilized for performing complex analyses like 

regression or correlation
• Data models enable tracking and visualizing project 

progress over time
• They can help streamline supply chain operations by 

integrating inventory, sales, and delivery data
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Today We Discussed
• Comprehensive grasp of Excel's Tables and Data 

Modeling

• Introduction and exploration of Excel Power Query

• Analysis of Power Query's tabs and user experience

• Examination of various Power Query connection 
options

• Techniques for common Power Query data 
transformations

• Guidance on connecting to Web, SQL, and ODBC data 
sources

• Brief look at Advanced Power Query topics
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